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1. Shdafaqm # dRIshHER &l = 1. Bioinformatics is primarily applied in

PSP biology for :
3 fohges foru feran ST © 2 tology or
(A) ifass Frami =1 s1eme (A) Studying physical laws
(B) S T IR THEHR  H (B) Analyzing and interpreting
foYerooT T8 = biological data and information
(C) Taxita sAfyerEl o1 gaieM (C) Managing financial records
(D) SiENfr THmEfe ARl & (D) Designing industrial chemical
frtor compounds
2 frefafed § 9 aH-91 Sfas e,q—j-gqm 2. Which of the following represents a

major application of bioinformatics in

T IrEhIHCH T @ AT § ? T
biological research ?

(A) € Trnfae arened o1 faerd (A) Developing new programming
languages
(B) WM W= IR &HE @ (B) Predicting protein structure and
N function
(C) Hfeh Iushull ot fmfor (C) Designing mechanical devices
(D) mséﬁﬁﬂ gfehe SAMT (D) Building digital electronic
circuits

3. fTrAfafed § 9 - e fearg = 3. Which of the following is an example
of an input device ?

S 7§ ?

(A) fiX (A) Printer

(B) T (B) Monitor
(C) = (C) Keyboard
(D) TR (D) Speaker

B170602T (2) Set-A



FR H ATRfeT faen (0S) &1 §&=A
FEFNT ?
(A) faem & TEoeRr iR diear

HHAT T GG HET

(B) TIATERH FX&T YSH Al

(C) TEAS 3R WeIMe oA
(D) FeTR FHAfFRIaS! Tnfad e

Yoo T e (CPU) I /T Sl
R

(A) fefSea gz

(B) T Ho[

(C) TR 1 Alsh

(D) TR H<Ag

FX fawen ¥ 7€ fewn gra (HDD)
&+ g HE FNE ?

(A) T TR 3R TOFT HET

(B) Trefhifersh  (AM-diierEel) €A
RS Y& T

(C) YW v & foq sTearl JaRy
TR Al

(D) @l TAYL/3MEeYe SUHLN 9
$HY HAT

B170602T

(3)

The operating system (OS) in a
computer primarily functions to :

(A) Manage hardware and software
resources of the system

(B) Provide antivirus protection

(C) Create documents and
spreadsheets

(D) Establish internet connectivity

Central Processing Unit (CPU) is

considered as :

(A) Digital computer
(B) Analogue computer
(C) Brain of computer

(D) Power supply

The primary function of a hard disk

drive (HDD) in a computer system is

to :

(A) Perform data processing and
calculations

(B) Provide long-term (non-volatile)
data storage

(C) Offer temporary memory for
executing programs

(D) Interface with external

input/output devices

Set-A



HF-TN FHX ARG HE I T2
i oiR o TRfaT & fr s
foren ST © 2

(A) FTHEA

(B) HRFIR

(C) wETA hER

(D) A=z

FR F e il § e afrem
(ICs) 1 ITART Y& g3 ?

(A) e el

(B) T i

(C) et i

(D) et dicd

fhe YRR T AHR AH-Sieiersd Bt §
3R refwIfae 2o RRS & fau 3w
T S 2

(A) ™

(B) W

(C) &% B

(D) =€ few=h

B170602T

(4)

Which type of computer is used for
personal tasks such as browsing the

internet and word processing ?

(A) Mainframe
(B) Supercomputer
(C) Personal Computer

(D) Minicomputer

Which generation of computers

introduced the use of integrated

circuits (I1Cs) ?

(A) First Generation
(B) Second Generation
(C) Third Generation

(D) Fourth Generation

Which type of memory is non-

volatile and is used for long-term data

storage ?

(A) RAM
(B) ROM
(C) Cache Memory

(D) Hard Disk

Set-A



10.

11.

12.

Excel # 91 &t IR &l guifed w7 10.

& foau f=fafea § 9 sA-1 vidse

ST fohar San § 2

(A) F2
(B) F4
(C) F7
(D) F10

Excel # Scatter Chart =1 q&g swm 11

ferereh foru fopan ST © 2

(A) SRl & ST &t feem

(B) HHH & WY T @™

(C) TTT-3TeTT AT hi Tl T

(D) < OEHS® W & o I B
[EESEL TS

Excel § Al & W 9on &1 sfgg 12

e & fau ®F- wRE STEm
fra S g ?

(A) SUM

(B) COUNT

(C) AVERAGE
(D) MAX

B170602T (5)

Which of the following shortcuts is
used to edit the content of a cell in

Excel ?

(A) F2
(B) F4
(C) F7
(D) F10

Scatter Chart in Excel is primarily

used for :

(A) Displaying  proportions  of
categories

(B) Showing trends over time
(C) Comparing discrete categories

(D) Analyzing the relationship

between two quantitative
variables
Which Excel function is used to

calculate the average of a range of

values ?

(A) SUM
(B) COUNT
(C) AVERAGE
(D) MAX

Set-A



13.

14.

15.

fafafed § ¥ &9 T& Te-2-

o o

ISy

Zel UL ITHTT] KT ISR § ?

(A) HEFRIBH
(B) T
(C) HifeX
(D) firx

frafafed § ¥ =9 faiee =R
IYHT HT YR T ?

(A) W™

(B) W

(C) = fem=h

(D) Ry

Excel # fFt 9@ H €1 RY & &
g e’ il T TR FIT AT § 2

(A) T AfHT & |

i @FT 3T hicTH ﬁ ENIESIG
gl

Gfera ¥ ST ufeh | =T S
gl

Tfsha et Rt A g A T

(B)

(©)

(D)

B170602T

(6)

13.

14.

15.

Which of the following is an example

of an analog-to-digital conversion

device ?

(A) Microphone
(B) Speaker

(C) Monitor
(D) Printer

Which of the following is a type of

secondary storage device ?

(A) RAM
(B) ROM
(C) Hard Disk

(D) CPU

What happens when you press the

“Enter” key after typing data into a

cell in Excel ?

(A) The cell remains active.

(B) The active cell moves to the next
column.
(C) The active cell moves to the next
row.
(D) The active cell deletes the
content.
Set-A



16.

17.

Excel # Combo Chart =T 35T fehdeh

fore foran s & 2

(A) T & =9 § fafy= geRr & =
EHNEERE!|

(B) T =i & orw oy fe@m

(C) =1 = Wi (columns) & &4 H

TR

(D) 3TU ! IR &9 H fe@r

Excel § "SUM" HeRTH -1 Hidl § ?

(A) Te| i e firmar g1
(B) ¥cd &I TH it H HAl ol
Sredr 1

(C) it H Tod Biel JooI urdT |

(D) St & oY ST YoF Il S

B170602T

(7)

16.

17.

Combo Chart in Excel is used for :

(A) Displaying multiple chart types
within a single chart

(B) Plotting relationships between
two variables

(C) Representing data using vertical
bars

(D) Showing proportions in a

circular form

What does the “SUM” function in

Excel do ?

(A) Counts the number of cells

(B) Adds up the values in a range of

cells

Finds the smallest value in a

(©)

range

(D)

Finds the largest value in a range

Set-A



18.

19.

20.

P Yeardcl § RAM &l qU M I
€ ?

(A) Teu TRE TEN

(B) s TFE HAN]

(C) e ww JuR

(D) TTd-TrEH g 7l

ffafed § ¥ ®F sAfcdd ©RS
e 1 /AT ?

(A)  FTE TR g

(B) <EretEt

(C) THTHE

(D) ardt fewn

Microsoft Word T Teh & HiFaaT
T /S 7

Tt HiRTR

HHIER

e ffeferet

(A)

(B)

(©)
(D)

B170602T

(8)

18.

19.

20.

What does RAM stand for in computer

terminology ?

(A) Random Access Memory
(B) Read Access Memory
(C) Rapid Access Memory
(D) Real-time Access Memory

Which of the following is an example

of optical storage media ?

(A) USB Flash Drive

(B) DVD

(C) SSD

(D) Floppy Disk

Microsoft Word is an example of

which type of software ?

(A) Operating system software

(B) Application software
Firmware

(©)

(D) System utility

Set-A



21.

22.

23.

frfafeg 4 @ sA-@ o3 fefsea
Hehdl ! TATANT Hehal H URafdd i
T2

(A) TieH

(B) w=™

(C) wHuHEt
(D) =

ST 1 &7 fordanT 31egaa il
g2
(A)  SHEE & G SR wrE

(B) e wfafsrens®t # oyupsii &1
SRR
(C) It & siifaes T

(D) el ST IR o

S § 3R R fohd i o

ST foha Sran & ?

ecas i i - op e D3] )

L SREH HEFAET (NGS)

(A)
(B)

N AN

qreitats = Ru™ (PCR)

(©)

ST HISShIEeh

(D)

B170602T

(9)

21.

22.

23.

Which of
converts digital

the following devices

signals to analog

signals ?

(A) Modem
(B) Mouse

(C) SSD

(D) Printer

What does the field of genomics
study ?

(A) The structure and function of
genomes
The behavior of molecules in

(B)

chemical reactions

The
materials

©) physical properties of

(D)

The anatomy of plants

Which of the following technologies is
commonly used in genomics ?

(A)

(B)

X-ray crystallography
Next-generation
(NGS)

Polymerase
(PCR)

sequencing

chain reaction

(©)

(D)

Electron microscopy

Set-A



25.

26.

B170602T

(A) W& 3R 3HT TEATT

(B) SIRTAT THlheH
(C) IR H Hereliensed
(D) fafue Fyeom

St syt 1 "W & fau
TEfReir # TRR fohe qoheh 1
ST feRa ST ¥ 2

(A) T At

(B) T TR

(C) STRUTT FRITET (RNA-seq)
(D) ELISA
TEreifierd fhge I oM | s1eam
€7

(A) fafres

(B) RS

(C) I TfaeH

(D) W

(10)

24,

25.

26.

Transcriptomics focuses on the study

of which of the following ?

(A) Proteins and their structures

(B) RNA transcripts

(C) Metabolites in cells

(D) Lipid synthesis

Which technique is often used in

transcriptomics to measure gene

expression ?

(A) Western blotting

(B) Mass spectrometry

(C) RNA sequencing (RNA-seq)

(D) ELISA

Proteomics is the large-scale study of
what ?

(A) Lipids

(B) Carbohydrates

(C) Nucleic acids

(D) Proteins

Set-A



27. URiehfHed # dudt § WReE @ UgEH
FE % fau s W few fafy
SERILRERIES I
(A) ST TRIBRREE
(B) IR
(C) A TRmE
(D) TIPS

28. HeEcltied frefafed § @ fordem
ST HYAT € ?

(A) Sfei # fafre dremed
(B) wIf¥TeRIST H Heraasd
(C) WM ST

(D) Hfes =iee

29. TrAfafed & ¥ M- dheh TR
R HTEelited § B 317 Heeiazed
T H & oAU SuE &) Sl § 2
(A) SRR THfew WHE (NMR)

TerrEah T
(B) dielms =« RuaR™ (PCR)
(C) uferEm
(D) o= =i
B170602T

(11)

27.

28.

29.

Which method is commonly used in
proteomics to identify proteins in a

sample ?

(A) Gel electrophoresis
(B) Chromatography

(C) Mass spectrometry
(D) Spectrophotometry

Metabolomics is concerned with the

study of which of the following ?

(A) Lipid profiles in organisms
(B) Metabolites within cells
(C) Protein interactions

(D) Genetic mutations

Which of the following techniques is

commonly  applied to study

small-molecule metabolites in

metabolomics ?

(A) Nuclear Magnetic Resonance
(NMR) Spectroscopy
(B) Polymerase Chain  Reaction
(PCR)
(C) ELISA
(D) Western Blot
Set-A



30.

31.

32.

B170602T

ISR § HifeTeshd oM 3R
< fovetour & foq sE-E g
TS W 3fereR ST Y S § 2
(A) Python

(B) Java

(C) C++

(D) R

IRt # e Qe iR
forgerom & fau frfafed § & wE-d
G 9T SAT9ek ®9 9§ YA ohI
STt € 2

(A) SaTfEre

(B) TN

(C) HTML
(D) fTaEw

SEg-wferg § oe-enenia sryEr
a1 fofaa w0 & fau smwik w
HIF-H TS ITART T Sl § 2

(A) Tl

(B) U

(C) St

(D) diw=rdt

(12)

30.

31.

32.

Which programming language is most
widely used for statistical computing

and data analysis in bioinformatics ?

(A) Python
(B) Java
(C) C++
(D) R

Which of the following programming
languages is known for its extensive

use In bioinformatics for data

manipulation and analysis ?

(A) JavaScript
(B) Python
(C) HTML

(D) Swift

In bioinformatics, which language is
commonly used for developing web-

based applications ?

(A) Ruby
(B) Perl
(C) Java

(D) PHP

Set-A



33.

34.

35.

B170602T

SRiEhHcH # fepfen &R Jwe
TrEfET & foag fre sren &1 3w fohan
S S 2

(A) T

(B) e

(C) wigH

(D) TEREA

o (a3

fFrefafed § | SH-91 SRighHfe
@Est Python H forkfira & ofR ergsrm
fergereror qen Siferr S grafET & fog
SUH el € ?

(A) BioPerl

(B) BioJava
(C) BioR

(D) Bio Python

Sifaeh S2EE 1 G&F SexT FNE 2

(A) foxita Rei€d =1 U &

(B) Sifoss B2 & WUEM & 3R
AT AT

(C) WIFeR—R 3TIUar 1 fam

(D) eIt At S

(13)

33.

34.

35.

Which language is known for its use in

scripting and text processing in

bioinformatics ?

(A)  Perl
(B) COBOL
(C) FORTRAN

(D) SQL

Which of the following is a widely used
bioinformatics library implemented in
Python for sequence analysis and

biological data processing ?

(A) BioPerl
(B) BioJava
(C) BioR

(D) BioPython

What

biological database ?

is the main purpose of a

(A) Storing financial records

(B) Storing and organizing
biological data
(C) Developing software appli-

cations

(D) Creating multimedia content

Set-A



36.

37.

38.

B170602T

freafafed & 9 =1 T mafas Sfaw

ST T ISR § ?
(A) Taa-te

(B) e

(C) wW-wume

(D) chESirsht

Tigfeh ey §& €4 9 frd g &
<2 ! IR L & oy foeer 2
g7

(A) faverfta 2=

(B) TIfurdiy Afeew

(C) TR FHE

(D) heal TS S

T fegdtae 2w # IHdr W fwa

R ! STHehRI GIEId Bl § 2

(A) el ATHA S

(B) wufr B H FRAT 3R
femforat

C) fofta 2

(D) weHHifean Thged

(14)

36.

37.

38.

Which of the following is an example

of a primary biological database ?

(A) Swiss-Prot
(B) GenBank
(C) Prosite

(D) KEGG

Primary  databases are  mainly

responsible for storing which type of

data ?

(A) Analyzed data
(B) Mathematical models
(C) Software code

(D) Raw experimental data

What type of information is typically
stored in a secondary database ?

(A) Raw sequence data

(B) Annotations and interpretations

of primary data

(C) Financial data

(D) Multimedia files

Set-A



39.

40.

41.

B170602T

(a3 o

fefafed § 9 ®F T fedias Sfas

S T ?
(A) TTHISTeTE
(B) IUHsiA
(C) Tt
(D) Ffme

mafaes AR fgdias Seeg 9 T 997
2O ] AT AT FLAT § ?

(A) IE haa foxia ST FIEA Ll
g
(B) ¥E % Wil W S ! ST ¥ |

(C) ug difedl ¥uRH & foaw ST
fopam S 2|
(D) TEH Sifas 21 & el |

HA-| e fafe= gl ¥ STeRT
1 THIFT H WA IRAR & FHrfcs
foverm &t glaa e § 2

(A) THETEE (Prosite)

(B) SHs (GenBank)

(C) et (PDB)

(D) &7 (KEGG)

(15)

39.

40.

41.

Which of the following is a secondary
biological database ?

(A) NCBI
(B) EMBL
(C) PDB
(D) UniProt

What

database from primary and secondary

distinguishes a composite

database ?

(A) It stores only financial data.

(B) It combines data from multiple
sources.

(C) Itisused for video editing.

(D) It does not contain biological
data.

Which database integrates information

from multiple sources to provide

functional  analysis of  protein

families ?

(A) Prosite
(B) GenBank
(C) PDB

(D) KEGG

Set-A



42.

43.

44,

B170602T

SHH-91 ey fave ®9 9 UM

TEAIRT Rl WUEI i o fau fesme
fF T g ?

(A) SHS®

(B) TSt (WA 221 o)

(C) ettt

(D) AFSi

3TIHA WEm & fou ffafed § 9
- STHTO AR T ITAM foma

SR ?

(A) ==

(B) THA

(C) RIS

(D) sierhe

FHA-F HRRR  AMe ®9 9§
FRASHfeR T TN & forn Iwim
fran ST g ?

(A) ENECNEESS |
(B) M
(C) ==

(D) THHIA

(16)

42.

43.

44,

Which  database is  specifically

designed  for  storing  protein

structures ?

(A) GenBank

(B) PDB (Protein Data Bank)
(C) KEGG

(D) UniGene

Which of the following is a commonly

used tool for sequence alignment ?

(A) BLAST
(B) Excel

(C) Photoshop
(D) AutoCAD

Which software is widely used for

constructing phylogenetic trees ?

(A) Clustalw
(B) MEGA
(C) BLAST

(D) RASMOL

Set-A



45.

46.

471.

B170602T

AEAEHHCR H BLAST 2o &1 q&9 45

FEFNE ?
(A) 3TIHY TEU 3R THEA S

(B) 3HS HUREH
(C) SIMe Tl
(D) S99 JEEH

frafafed & & fvg < o1 SwEm 46

THITY® STIhH T@U & o fohan S
€7

(A) T AHT

(B) THTH=E

(C) T

(D) TEHTHTH

Yied Rl &l Qe & fau ey
SREHHCHRT T sl YA Than Sl
€ 2

(A) =M

(B) =

(C) dIHA

(D) wFREASTY

(17)

47.

What is the primary function of the

BLAST tool in bioinformatics ?

(A) Sequence alignment and

similarity search

(B) Image editing
(C) Spreadsheet calculation
(D) Database management

Which of the following tools is used

for multiple sequence alignment ?

(A) Clustal Omega
(B) MS Word

(C) MATLAB

(D) SPSS

Which bioinformatics tool is used to

visualize protein structures ?

(A) MEGA
(B) BLAST
(C) PyMOL

(D) Clustalw

Set-A



48. S TARIH & fow omdr W few 48

TS 1 ITANT fopel ST ¥ 2
(A) s

(B) TEH WRRI

(C) sfdrhe

(D) TR

49. SISt STod W &I ITANT 1§ 7 49.

o (a

(A) foxita g1 9uda e
(B) TemEifelh Wod 3R TRERWH A
forgetoror s

(C) TTtherT TeSTe &L

(D) I fawerso LT

50. NCBI &1 QU A9 F1 § ? 50.

(A) WEA TR R SRS
ST

(B) WM& S+ TR SESIRel
EEPNE

(C) “RMe TR R srshifery T
ERIENE]

(D) A HHS X ASRIHICHT

B170602T (18)

Which tool is commonly used for

genome annotation ?

(A)
(B)
(©)
(D)

Artemis
Adobe Photoshop
AutoCAD

Excel

What is the main use of the KEGG
database ?

(A)
(B)

(®)
(D)

Storing financial data

Analyzing metabolic pathways

and interactions

Designing graphics

Conducting statistical analysis

What is the full form of NCBI ?

(A)

(B)

(©)

(D)

National Center for

Biotechnology Information

National Council for Biological

Integration

National Center for

Bioinformatics and Innovation

National Committee for

Bioinformatics

Set-A



51.

52.

53.

B170602T

BLAST &1 qU 99 1 § ?

(A) dEHfEHR  ARIE SAANRIH
foen za
(B) WHfShel  od  TATAfEE

oI Soih

o N

(C) dfeh Tiehel STaTTETHE ¥4 2d

(D) dRiEhiHECHR wifaed W 99

o

o

TEEhTHfer Seed § Entrez gt

* =T Jfamr F E 2

(A)  STHT TEU FHE

(B) TREH ¥ Jfgw TSR BieH!
3R YT T

(C) THS WEET T

(D) WIEHHTA TUAT HEAT

frfafed § 9 ®HE-91 2d See9 9
Sifereh STIRHl I A: W & & o
AR WR 3TN e S © 2

(A) Feow

(B) TSI WY

(C) =

(D) TwsREH

(19)

51.

52.

53.

What does BLAST stand for ?

(A) Biometric Location Algorithm
System Tool

(B) Biological Lab
Software Technique

Analysis

(C) Basic Local Alignment Search
Tool

(D) Bioinformatics
Search Tool

Logical Array

What is the primary role of the Entrez
system in bioinformatics databases ?

(A) Performing sequence alignment

(B) Searching and retrieving
biological data from databases

(C) Processing images

(D) Performing statistical compu-

tations

Which of the following tools is

commonly used for retrieving

biological sequences from databases ?

(A) MATLAB
(B) Adobe Photoshop
(C) BLAST

(D) SRS

Set-A



54. oTuifosh  Safo™ H S STIHRA
(gene sequencing) 1 T&A IexA
g2
(A) fefsea fasi =1 gurgA
(B) <ITAT 31I%A H fRTderEed &
ek A o1 i

(C) U st | HIYAT

(D) @M & (phylogenetic tree)
A

55. Iea-gUe S ATHAU & AU AHAR
R fohe qehrich T 3TAN fohan S § 2
(A) TR Fafan
(B) TSTH
(C) e =t
(D) a%=A sdffen

56. WM ST 1 & SexT 1T ?
(A) T& URH | T Tfaed & %A

1 iR e
(B) T fefStea sfa oM
(C) T =icl &1 UITH AT
(D) SAHIRTeR WA Rl FUTfed T
B170602T

(20)

54.

55.

56.

What is the primary objective of gene

sequencing in molecular biology ?

(A) Editing digital images

(B) Determining the precise order of
nucleotides in a DNA sequence

(C) Measuring protein concentration

(D) Constructing phylogenetic trees

Which technology is commonly used

for high-throughput gene sequencing ?

(A) Sanger sequencing

(B) NGS

(C) Northern blotting

(D) Western blotting

What is the primary goal of protein

sequencing ?

(A) To determine the sequence of
amino acids in a protein

(B) To create a digital image

(C) To measure the pH of a solution

(D) To edit genetic material
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57.

58.

59.

Which method is commonly used for

protein sequencing ?

(A) Gel electrophoresis
(B) PCR
(C) Edman degradation

(D) Southern blotting

What is the primary function of

ClustalW in bioinformatics ?

(A) Multiple sequence alignment of

DNA or protein sequences

(B) Sequence submission to

databases

(C) Genome annotation
(D) Protein structure prediction

What is the main purpose of similarity

searching in bioinformatics ?

(A) To find similar sequences in a
database

(B) To edit biological images
(C) To create mathematical models

(D) To store financial data
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What is pair-wise sequence alignment
used for ?

(A) Creating 3D models

(B) Comparing two sequences to
identify regions of similarity

(C) Editing genetic material

(D) Conducting chemical reactions

Needleman-Wunsch algorithm is used
for:

(A) Local sequence alignment
(B) Database searching
(C) Multiple sequence alignment

(D) Global alignment of biological
sequences

What is multiple sequence alignment ?

(A) Editing
simultaneously

multiple images

(B) Aligning one sequence with a
3D model

(C) Aligning than  two

sequences to identify regions of

more

similarity

(D) Aligning chemical formulas
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In bioinformatics, what does MSA
stand for ?

(A) Multiple Sequence Alignment
(B) Molecular Structural Analysis
(C) Medical Statistical Analysis

(D) Microbial Sample Analysis

What is the definition of biostatistics ?

(A) The analysis of financial markets
(B) The study of plant biology

(C) The application of statistics to
biological and health sciences

(D) The study of environmental

sciences

Which of the following is a commonly
used statistical method in biostatistics
for analyzing relationships between

variables ?

(A) Regression analysis
(B) Chromatographic separation
(C) DNA sequencing

(D) Image processing
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67.
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Data compilation in biostatistics refers
to:

(A) Collecting and organizing data
for analysis

(B) Performing statistical tests
(C) Interpreting experimental results

(D) Presenting data graphically

In biostatistics, classification refers to :

(A) Physical
samples in a laboratory

categorization  of

(B) Arrangement of data into
meaningful groups or classes for
analysis

(C) Graphical

variables

representation  of

(D) Statistical testing of hypotheses

What is tabulation in the context of
biostatistics ?

(A) Arranging data in tables for easy
interpretation

(B) Writing novels
(C) Composing music

(D) Designing clothing
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71.

How is biostatistics applied in life

sciences ?

(A) To analyze experimental data

and draw conclusions

(B) To build computer software
(C) To design vehicles
(D) To construct bridges

What is the
of  graphical

primary  purpose
representation  in

biostatistics ?

(A) To visually present data for

easier interpretation

(B) To

calculations

perform statistical

(C) To collect experimental data
(D) To store data in databases

Which of the following is a common

graphical representation used in

biostatistics ?

(A) Histogram
(B) Pie chart
(C) Linegraph

(D) All of the above
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What does probability theory in

biostatistics helps to determine ?

(A) To visually display data for
easier interpretation
(B) The color of a flower

(C) The likelihood of an event

occurring

(D) The shape of an object

Which distribution is commonly used
in biostatistics for modeling binary

outcomes ?

(A) Normal distribution

(B) Binomial distribution
(C) Poisson distribution

(D) Exponential distribution

What is a normal distribution often

referred to as ?

(A) Triangle curve
(B) Square curve
(C) Bell curve

(D) Zigzag curve
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75.

76.

77.

drawback of
methods in

What is a potential

relying on statistical

biological research ?

(A) Data may be misinterpreted if
not properly analyzed

(B) Statistics always provide
flawless conclusions
(C) AIll  experimental errors are

removed through statistics

(D) Statistics are limited to use in
chemical studies only

How can the limitations of statistics be
mitigated in life sciences research ?
(A) By avoiding data collection

(B) By ignoring statistical errors

(C) By using outdated methods
(D) By using rigorous data collection
and analysis methods

A study records the weights (in kg) of
8 patients as : 50, 55, 60, 65, 70, 75,
80, 85. What is the mean weight of the
patients ?

(A) 65kg
(B) 67.5kg
(C) 70Kkg
(D) 72.5kg
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78.

79.

80.

81.

In the data set 45, 50, 55, 60, 65, what
is the median value ?

(A) 50
(B) 55
(C) 60
(D) 65

A bag contains 3 red, 7 blue, and 10
green balls. If one ball is drawn at
random, what is the probability of
selecting a green ball ?

(A) 3/20

(B) 7/20

(C) 10/20

(D) 13/20

When two fair six-sided dice are
rolled, what is the probability of
obtaining a total sum of 7 ?

(A) 5/36
(B) 6/36
(C) 7/36
(D) 1/12

In biometry, what is a population ?

(A) A collection of all individuals or
items under study

(B) A subset of a larger group
(C) A group of animals

(D) A sample of data points
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82.

83.

84.

What is random sampling ?

(A) Selecting samples based on

researcher preference

(B) A method where each member
of the population has an equal
chance of being selected

(C) A method used only for small
populations

(D) Choosing samples in a specific
sequence
What is stratified sampling ?

(A) Sampling only the first few
individuals

(B) Randomly selecting individuals
without any grouping

(C) Dividing the population into
subgroups and sampling each
subgroup

(D) Selecting every nth individual
from the population

In systematic sampling, how are

samples selected ?

(A) By stratifying the population and
selecting from each group

(B) By randomly picking individuals
from the population

(C) By choosing only the first
individuals

(D) By selecting every nth individual
from the population
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What does a frequency distribution
represent in statistical analysis ?

(A) A summary of how often each
value appears in a dataset

(B) A method for calculating mean
values

(C) A step involved in hypothesis
testing

(D) A graphical tool for regression
analysis

Which of the following is NOT a
measure of central tendency ?

(A) Mode

(B) Mean

(C) Median

(D) Variance

What is the arithmetic mean ?

(A) The sum of all values divided by
the number of values

(B) The middle value in a sorted data
set

(C) The value that appears most
frequently in a data set

(D) The difference between the
highest and lowest values
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In a data set, the mode represents
which of the following ?

(A) The middle value
(B) The average of all values

(C) The value that appears most
frequently

(D) The between

maximum and minimum values

difference

What does the coefficient of variation
(CV) measure in a dataset ?

(A) The ratio of standard deviation

to the mean

(B) The difference between the

highest and lowest values

(C) The average of the squared
differences from the mean

(D) The sum of all data points

What is the standard deviation ?

(A) A measure of the dispersion of
data points around the mean

(B) The average value of a dataset
(C) The highest value in a dataset

(D) The median of a dataset
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What does the standard error of the
mean (SEM) represent ?

(A) The variability of the sample
mean estimate of a population
mean

(B) The total number of data points

(C) The range of the data

(D) The standard deviation of the
data set

What is the primary purpose of the
Chi-square test ?

(A) To find the median of a sample

(B) To calculate the mean of a data
set

(C) To test the association between
two categorical variables

(D) To determine the standard
deviation
Which of the following is a

requirement for applying the chi-
square test ?

(A) The data must be categorical

(B) The data must be normally
distributed

(C) The data must be continuous

(D) The sample size must be small
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Which of the following can be
calculated using MS Excel’s statistical

functions ?

(A) DNA sequencing

(B) Mean,

standard deviation

median, mode, and

(C) Gene editing
(D) Protein synthesis
Which Excel function would you use

to calculate the standard deviation of a
dataset ?

(A) =STDEV()
(B) =AVERAGE()
(C) =SUM()
(D) =MEDIAN()

How can you create a frequency
distribution table in MS Excel ?

(A) By using the Sort feature

(B) By manually entering data into

cells

(C) By using the PivotTable feature

(D) By using the Merge feature
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97.

98.

99.

100.

What is SPSS primarily used for ?

(A) Database management
(B) Video editing
(C) Website development

(D) Statistical analysis

In SPSS, which feature is used to
perform a Chi-square test ?

(A) File > New > Chi-Square

(B) Analyze > Descriptive Statistics
> Crosstabs

(C) Edit > Options > Chi-Square

(D) View> Toolbar > Chi-Square

Which type of data is most appropriate

for statistical analysis in SPSS
software ?

(A) Multimedia data (audio/video)
(B) Quantitative numerical data
(C) Unstructured image data

(D) Raw signal data

20,480 kilobytes (KB) is equal to how

many megabytes ?

(A) 5MB
(B) 10 MB
(C) 20MB
(D) 40 MB
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